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C H A P T E R

1

Introduction 1

This manual describes how to set up and use the 
Trimble® AllTrak™ software.

This publication assumes that you are know how 
to use the Windows® operating system.

About this product
The AllTrak software enables you to track 
assets, so you always know exactly where they 
are, the condition of the asset, and the person 
responsible for the asset.

The AllTrak software enables you to easily 
check your assets in and out and transfer them 
between locations (where your assets are 
actually being used). 

About this manual
This manual includes instructions on installing 
the AllTrak software and associated software 
applications (if you are using these). It also 
includes installing scanner software (if you are 
using this feature) and the preliminary steps 
required before you start working in the 
database. 

Trimble recommends that you briefly review all 
chapters of this manual before you begin the 
installation process.

After you have completed the steps outlined in 
this manual, you are ready to begin adding assets 
to your database. 

Related information
The AllTrak software includes both online 
manuals and help that detail the steps required to 
set up your database. You can access all manuals 
online from the software (select Help / Trimble 
AllTrak Manuals) or from the Windows Start 
menu. (Navigate to / Trimble Office / Trimble 
AllTrak/ Documentation). Sources of related 
information include the following:

• AllTrak Software QuickStart Guide steps 
you through the implementation process 
so you can start using the AllTrak 
software as soon as possible.

• AllTrak Software Barcodes and Scanners 
Guide for those who will use a scanner 
with the application.

• Online Help – the software has built-in, 
context-sensitive help that lets you 
quickly find the information you need. 
Access it from the Help menu. 
Alternatively, click the Help button in a 
dialog, or press [F1].

• Release Notes – the release notes describe 
new features of the product. Release 
Notes and any files available to download 
will be available from the support area of 
the Trimble website.
AllTrak Software Installation Guide     6



1      Introduction
• Trimble online training courses – Trimble 
strongly recommends that you attend at 
least one online training class before you 
begin to work in the AllTrak software. 
This will provide you with the 
information needed to help you 
successfully implement your database. 
With proper implementation, you will 
receive the most benefit from using the 
AllTrak software. Note: All classes are 
conducted over the internet. For class 
schedule information, call 1-800-441-
2840.

Technical support
You can also contact AllTrak technical support st 
1-800-441-2840 or at ATSupport@trimble.com.

Your comments
Your feedback about the supporting 
documentation helps us to improve it with each 
revision. Email your comments to 
ReaderFeedback@trimble.com.
7      AllTrak Software Installation Guide
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C H A P T E R

2

Overview and Requirements 2

In this chapter:

■ Network

■ Stand-alone

■ DataServer software

■ Trimble® Quick Link

■ Preliminary installation 
requirements

The AllTrak software can be installed on a 
network or on a stand-alone/single-user 
computer. When installed on a network, it runs 
in a client/server environment. 

This chapter gives you an overview of the 
installation process and installation 
requirements.
AllTrak Software Installation Guide     8



2      Overview and Requirements
Network
If you install the software on a network, the database is contained in one location with 
access granted to various users at certain levels. Network installation also provides a 
central location for database management, maintenance, and backups. After installing 
on the designated server, you must install the software on each workstation that needs 
access to the database. The database is most likely backed up daily through system 
backups by your System Administrator; however, Trimble recommends that you also 
perform regular backups of the AllTrak database using the scheduled backup feature 
to ensure that your data is safe-guarded.

Stand-alone
Installing the software on a single-user computer allows access to the database on 
only that computer. It also provides a central location for the database, but no access 
from workstation computers. When the AllTrak software is installed on a stand-alone 
computer, perform routine backups of the database and save them on a network 
location or other media (for example, USB drive, DVD-RW, CD-RW) to ensure that 
the data is not entirely lost in emergency situations.

DataServer software
The AllTrak software requires DataServer software, which is automatically installed 
when you install the application (either on a network or stand-alone computer). The 
AllTrak DataServer manages all database information.

Trimble® Quick Link

B Tip – You must install Trimble Quick Link before installing Trimble AllTrak.

The Trimble Quick Link software utility allows you to easily manage licenses for 
your Trimble software products. The AllTrak software requires Trimble Quick Link 
for licensing and communication purposes. The software will not run without the 
Quick Link product.

The Trimble® Quick Link software has two modules available.

Trimble Recommendations:

• Install Trimble Quick Link
You must install Trimble Quick Link before you install the AllTrak 
application.

• Trimble Quick Link Hub
The Hub serves as the central communication link between AllTrak and Quick 
Link Central (licensing server) located in Trimble’s corporate offices. The 
Quick Link Hub must be installed before you can install AllTrak.
9      AllTrak Software Installation Guide
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B Tip – Trimble recommends that the Trimble Quick Link Hub be installed in a central 
location accessible by all requiring access to Trimble software applications.

• Trimble® Quick Link Management Studio

– The Quick Link Management Studio allows you to manage your licenses 
from one convenient location. 

– Limiting the number of Management Studio installations within your 
organization provides better license management and security.

– Trimble recommends that you install at least one copy of the Management 
Studio at each or your company's physical locations.

Preliminary installation requirements
• To install the AllTrak software, you must have administrative privileges.

• Refer to the AllTrak System Specifications document for operating system 
compatibility. You can obtain this document from your local Trimble 
distributor.

AllTrak Support cannot assist you with hardware configuration issues. It is your 
responsibility to install the software and connect the required hardware. For 
assistance in such cases, check with the vendor who supplied the equipment, your 
local computer dealer, the documentation included with your hardware, and/or your 
company’s in-house computer experts.
AllTrak Software Installation Guide     10



2      Overview and Requirements
Verifying that TCP/IP is installed

The AllTrak software requires TCP/IP (Transmission Control Protocol/Internet 
Protocol). Verify that it is installed on your system before you install the AllTrak 
software.

1. Go to the Windows Start menu, navigate to Run. 

Note – The location of the Run command is based on your operating system:

– Windows XP users may find the command on the Start menu.

– Windows 7 users can simply type Run in the Search programs and files 
field.

2. In the Run dialog, enter Command and then click OK. 

Note – For certain versions of the Windows operating system, you may need to enter 
CMD in the Run window. Click OK. 

A window similar to the following displays:

a. At the prompt, enter IPCONFIG and then press [Enter]. If you have 
TCP/IP installed, the IP address for your machine appears.

B Tip – If the IP address does not appear or you get an error message, you must install 
TCP/IP on your computer before you can use the AllTrak software. Contact your SIT 
Professional for assistance.

b. To close the MS-DOS Prompt window, type exit at the prompt and 
then press [Enter].

Installation quick reference

Quickly locate the installation information you need using the following guide:

Installation type Installation quick reference

Trimble Quick Link See Chapter 3, Trimble Quick Link Installation

Network/Stand-Alone See Chapter 4, Network/Stand-Alone Installation.

Client Workstation See Chapter 5, Workstation Installation.
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Adobe Reader See Chapter 6, Adobe® Reader®.

Scanners Refer to the AllTrak Software Barcodes and Scanners Guide.

Installation type Installation quick reference
AllTrak Software Installation Guide     12
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C H A P T E R

3

Trimble Quick Link Installation 3

In this chapter:

■ Installation Recommendations / 
Requirements

■ Insert DVD

■ Trimble Quick Link Hub

■ Trimble Quick Link Management 
Studio

The Trimble® Quick Link software utility 
allows you to easily manage licenses for your 
Trimble products. AllTrak requires Trimble 
Quick Link for licensing and communication 
purposes. The software will not run without the 
Quick Link product.

Trimble® Quick Link has two modules 
available.

• Quick Link Hub
This module is required for 
communicating with Quick Link Central 
(licensing server). 

• Quick Link Management Studio
The Quick Link Management Studio 
allows you to manage your licenses. You 
can install it on one or multiple 
workstations.

Refer to the Trimble® Quick Link topic for 
more information.
AllTrak Software Installation Guide     14



3      Trimble Quick Link Installation
Installation Recommendations / Requirements
To ensure proper operation of Trimble® Quick Link after installation, follow the 
steps below.

BTip – You must install Trimble Quick Link before installing the AllTrak software. If you have other 
applications using the licensing utility, you do not need to install another Hub; however, you 
must install the release of Trimble Quick Link included with Trimble AllTrak (as an update) to 
ensure proper access to licensing functionality.

• You must have administrator privileges in order to install the software.

• Close all Windows-based applications on the server, including e-mail software.

• The Trimble Quick Link Hub must be installed in a central location accessible 
by all who require access to Trimble products. 

• You must install Trimble Quick Link before installing Trimble® AllTrak. If 
you have other applications using the licensing utility, you do not need to 
install another Hub; however, you must install the release of Trimble Quick 
Link included on this installation DVD (as an update) to ensure proper access 
to licensing functionality.

• If you are currently using Trimble® Quick Link for any other applications, you 
will need to also close the Quick Link Hub and Management Studio to 
complete the installation procedures. Keep in mind that any software 
application using Quick Link will not have access to licenses during this time. 
Trimble recommends that you do this during a non-busy time or after hours to 
minimize disruptions in your company’s workflow.

BTip – For Server 2008 and Server 2008 R2, you may need to enable the .NET Framework 3.0 
Features in the Server Manager. Contact your IT Professional if you need assistance with this 
process.

Insert DVD
1. Insert the AllTrak Installation DVD into the appropriate drive of the computer 

designated as the stand-alone or server computer. Wait a moment. 

2. If the installation does not start a few seconds after you insert the installation 
DVD, proceed as follows:

– Double-click on the My Computer icon.

– Locate the drive containing the AllTrak Installation DVD. Click on it to 
display the contents of the DVD. 

– Double-click AutoRun.exe to open the AllTrak main installation screen.

3. Refer to the "Hub Installation" on page 16 for complete instructions.
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Trimble Quick Link Hub

BTip – This installation may require a restart of your computer. Trimble recommends that you do this 
during a non-busy time or after hours to minimize disruptions in your company's workflow.

The Trimble Quick Link Hub provides communication with the Trimble licensing 
server. 

• Using the Quick Link Hub typically requires internet access to allow proper 
communication with the license server. If you do not have access to the 
internet, you must install the Quick Link Hub and then contact a technical 
support representative for further instructions. Note: You must have access to 
e-mail.

• Trimble recommends that you install the Hub on a computer that can be 
accessed by all software applications using the Trimble Quick Link software 
application.

• Only one installation of the Hub is required for all Trimble applications (at 
each location).

• If your company has multiple locations using Trimble software applications, 
you must install the Hub at each physical location. 

• If you are using the Trimble software as a Stand-Alone with no access to a 
network, you must install the Hub on that computer.

BTip – Trimble recommends that the Trimble Quick Link Hub be installed in a location easily 
accessible by all who need to use the AllTrak software

Hub Installation

To install the Trimble Quick Link Hub, proceed as follows:

1. On the main AllTrak installation screen, click Trimble Quick Link Installation 
(under Install).

2. In the Quick Link install screen, click Quick Link Hub.

3. The welcome screen displays. Click Next.

4. The License Agreement displays on the screen. Read the agreement. Choose I 
accept the terms of the license agreement. Click Next.

BTip – You must accept the terms of the agreement to proceed with the installation. If you want a 
hard copy of the agreement, click Print.

5. In the Choose Destination Location screen, click Next. We recommend that 
you accept the default location.
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6. In the Ready to Install the Program screen, read the information provided. 
When you are ready to begin the procedure, click Install. The procedure 
installs the required files and configures the service. Please be patient as this 
process may take a few minutes. 

7. Click Finish.

8. Open the Trimble Quick Link Hub to obtain the TCP/IP Address and TCP/IP 
Port for the computer where the software is installed. You need this 
information when installing AllTrak. Also, you need this information when you 
install the Management Studio.

Trimble Quick Link Management Studio

BTip – Trimble recommends that you limit the number of Management Studio installations within 
your organization. Limiting the number of Management Studio installations within your 
organization provides better license management and security.

1. In the Quick Link install screen, click Quick Link Management Studio. The 
routine prepares the files for installation. 

2. The Welcome screen displays. Click Next. 

3. The License Agreement displays on the screen. Read the agreement. Choose I 
accept the terms of the license agreement. Click Next.

BTip – You must accept the terms of the agreement to proceed with the installation. If you want a 
hard copy of the agreement, click Print.

4. In the Choose Destination Location screen, click Next. Note: Trimble 
recommends that you accept the default location.

5. In the Ready to Install the Program screen, read the information provided. 
When you are ready to begin the procedure, click Install.

6. Click Finish. Refer to the "Preliminary Settings" section in this manual for 
information on configuring the Management Studio. No action is required at 
this time.

Your TCP/IP address 
will be different than the 
one in the graphic. Do 
not use this address! 
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Return to Main Page
In order to install the AllTrak software, click  
and then refer to"Network/Stand-Alone Installation" chapter for instructions.
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4

Network/Stand-Alone Installation 4

In this chapter:

■ Trimble Quick Link

■ Installation options

■ Network installation reference

■ Preliminary steps

■ Installation procedures

■ Stand-alone/network procedures

This chapter describes how to install the AllTrak 
software for use on a network or a stand-alone 
computer. 
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Trimble Quick Link
The Trimble® Quick Link software utility allows you to easily manage licenses for 
your Trimble products. AllTrak requires Trimble Quick Link for licensing and 
communication purposes. The software will not run without the Quick Link product.

The Trimble® Quick Link software has two modules available.

• Trimble Quick Link Hub
You must install Trimble Quick Link before you install the AllTrak 
application. The Hub serves as the central communication link between 
AllTrak and Quick Link Central (licensing server) located in our offices. The 
Quick Link Hub must be installed before you can install AllTrak.

BTip – Trimble recommends that the Quick Link Hub be installed in a central location accessible by 
all requiring access to Trimble software applications.

• Trimble Quick Link Management Studio

– The Quick Link Management Studio allows you to manage your licenses 
from one convenient location. 

– Limiting the number of Management Studio installations within your 
organization provides better license management and security.

– Trimble recommends that you install at least one copy of the Management 
Studio at each of your company's physical locations.

AllTrak Installation Considerations
Before you begin, determine the environment in which the AllTrak software will be 
used. 

• Network
If you will be using it on a network, proceed with the instructions outlined on 
the following pages. After you have completed the installation on the 
designated server computer, you must also install the software on the 
workstations. See Workstation Installation, page 30.

• Stand-alone
If you are installing on a stand-alone computer, complete the procedures on the 
following pages.
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Installation options

Network installation

When you install the AllTrak software on a network, you must install the DataServer 
software on a designated network server. All AllTrak workstations then connect to the 
DataServer computer. 

Note – The AllTrak DataServer manages information in the database. 

• You can access the manual from the AllTrak Installation CD.

• After installation, you can open the manual from the Windows Start menu or 
from the Help.

Note – For more information about using a scanner with a network/workstation 
installation, refer to the AllTrak Software Barcodes and Scanners Guide. 

You can install both the AllTrak DataServer software and client-side on the 
designated network server. However, installing the application files (client-side) on 
the network server is not required. For information on the different installation 
options available, see Network installation reference, page 22. 

Stand-alone installation

When you install as a stand-alone user, you must install all components of the 
AllTrak software on the computer. You will be given this option in the installation 
routine.

Network installation reference

Select one of the following options that works best for your environment:

Type Advantages Disadvantages

AllTrak 
DataServer 
Installation

• All DataServer functionality is 
available.

• AllTrak program files are not 
installed so less disk space is 
required.

• Client-side security is not required at 
the server level.

• You cannot operate the AllTrak 
programs (client-side) at the 
DataServer.

• You can access the program (client-
side) only from workstations.

AllTrak Stand-
Alone 
Installation on 
the network 
server

• All DataServer functionality is 
available.

• You can operate the AllTrak program 
(client-side) on the network 
computer.

• You can access database functions 
from the server as well as from the 
workstations where the software is 
installed.

• Requires additional disk space.

• You may not be able to access the 
database if all available licenses are 
in use.
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Preliminary steps
Before you install the software:

• You must have administrator privileges in order to install the software.

• It is your responsibility to install the required software and connect the 
hardware (if necessary).

• Close all Windows-based applications on the server, including e-mail software.

Quick Link Hub IP Address

Before you can install Trimble AllTrak, the installation routine must validate 
installation and communication of the Quick Link Hub. You must have this 
information available to proceed.

Common installation commands

During the installation process, you will see the following in many of the dialogs:

• To proceed with the installation and advance to the next window, click Next.

• To return to the previous page, click Back.

• To stop the installation, click Cancel. You will be asked to confirm the 
cancellation. Click Yes if this was your intent. If you clicked Cancel in error, 
click No to continue the installation.

• To complete the installation, click Finish.

Your TCP/IP address 
will be different than the 
one in the graphic. Do 
not use this address! 
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Installation procedures
You must install the AllTrak software on the stand-alone computer or the computer 
designated as the server (network installation).

Network users

Before beginning the installation, you must also know the computer location (for 
example, the IP address or server name).

When you install the AllTrak software on a network server, you have two options:

• Install the DataServer only

• Install a Stand-Alone version on the server

For information on the advantages/disadvantages for each of these installation types, 
see Network installation reference, page 22.

BTip – The network installation must first be performed on the computer designated as the 
“network” or “database server”. This does not have to be the same computer already 
designated as your current network server. Workstation computers must be able to connect to 
this computer.

After you have completed the installation on the network server, you must install the 
AllTrak workstation software on all computers requiring access to the database. See 
Chapter 5, Workstation Installation.

Stand-alone users

Stand-alone users need only install the software on the designated AllTrak computer.

Insert DVD
1. Insert the AllTrak Installation DVD into the appropriate drive of the computer 

designated as the stand-alone or server computer. Wait a moment. 

2. If the installation does not start a few seconds after you insert the installation 
DVD, proceed as follows:

– Double-click on the My Computer icon.

– Locate the drive containing the AllTrak Installation DVD. Click on it to 
display the contents of the DVD. 

– Double-click AutoRun.exe to open the AllTrak main installation screen.
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Stand-alone/network procedures

C CAUTION – If you have not already done so, you must install Trimble® Quick Link before installing 
the AllTrak software. Refer to “Trimble Quick Link Installation” on page  14 for more information.

1. Select Install: Trimble AllTrak.

2. Trimble has built-in several validations to ensure Trimble® Quick Link and the 
Alltrak software can communicate properly after installation. Your Quick Link 
Hub must be validated before you can continue the installation. 

a. In the Check Quick Link Installation dialog, enter the following 
information:

Hub Address
This is the TCP/IP Address assigned to the Quick Link Hub.

Port
This is the TCP/IP Port assigned to the Quick Link Hub. Note: The default 
Port should always be 31958.

b. Click Continue Install.

c. Validation Procedure
When you click Continue Install, the application validates the installation 
and communication with the Quick Link Hub. 

– If the installation/communication is validated, the installation routine will 
proceed. Go to Step 3 below.

– If installation/communication cannot be validated, click Go Back and 
make sure you have entered the correct information. Make any necessary 
corrections and then click Continue Install again. Go to step 3 below.

BTip – If you have entered the correct information and the data cannot be validated, you will need 
assistance from your IT Professional. Trimble has provided an Installation Checklist document 
to step through some troubleshooting procedures in order to make sure your environment 
allows the proper required communication.

3. The InstallShield Wizard prepares to install the software. Please be patient. 
This may take a few minutes. 

4. The Welcome to the Installation Wizard for Trimble AllTrak dialog displays. 
Click Next.

5. The License Agreement dialog displays. Read the agreement. Select the I 
accept the terms of the license agreement option and then click Next. 

BTip – You must accept the terms of the agreement to proceed with the installation. If you want a 
hard copy of the agreement, click Print.
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6. Depending on the type of installation and/or operating system installed on your 
computer, the Access Control Options dialog may appear. Select one of the 
following options:

7. Click Next.

8. In the Select AllTrak Options dialog, select one of the following options:

Note – Do not select AllTrak Workstation for a network or stand-alone installation. 
For instructions on installing a workstation, see page 30.

9. Click Next.

10. The Choose AllTrak Destination Location dialog appears. Trimble 
recommends that you install the software in the default location. Click Next.

11. Depending on your system and other software programs installed, the Choose 
ASA Database Server Destination Location dialog may appear. Trimble 
recommends that you install the software in the default location. 

Note – If this dialog does not display, go to Step 12. Click Next.

12. The Select Other Options dialog appears. Depending on your preferences, 
select or clear the following check boxes:

Option Description

Access is allowed for 
anyone who uses this 
computer (all users)

This allows anyone who logs into your computer (regardless of 
user name) to access the database. However, they must be 
granted proper security rights in the AllTrak software.

Access is allowed only 
for me (computer or user 
name displays)

This allows only the login that matches the computer or user 
name to access the database.

Option Description

AllTrak Stand Alone 
(includes both 
DataServer and 
Workstation)

The Stand-Alone option on the network server provides full 
access to AllTrak (DataServer and client-side of the application) 
on the server computer.

Stand-Alone users: You must select this option.

Network users: You can choose this option or the DataServer 
option, depending on your preferences. For information on 
installation options, see Network installation reference, page 22.

AllTrak DataServer For Network users only: You can access only the DataServer 
on the computer designated as the server when you use this 
option. The client-side of AllTrak can be accessed only from 
workstations

Check box Description

Place the DataServer into the Startup 
menu

Automatically opens the DataServer when you 
log into your computer.
AllTrak Software Installation Guide     26



4      Network/Stand-Alone Installation
13. In the Enter TCP/IP Port dialog, enter the port number for the DataServer. 
Trimble has provided default values in these fields, but if you need assistance 
with the settings, contact your System Administrator. Click Next.

14. In the Select Program Folder dialog, choose how you want AllTrak 
information to appear in your program list. Trimble recommends that you 
accept the default setting. Click Next.

15. Set up scheduled backups of your AllTrak database. This enables you to back 
up your database on a daily basis at a specified time and location. Trimble 
recommends that you set these parameters during the installation procedure 
to safeguard data entered into the system.

You can modify settings later in the AllTrak DataServer window. For more 
information, refer to the DataServer Help.

a. Select the Yes option to set the options for Scheduled Backups and then 
click Next.

b. Do one of the following:

–Enter the location (drive letter and folder) where you want to create the 
backups. 

–Click Browse, then navigate to the location and modify it. 

BTip – Trimble recommends that you accept the default backup location. To create the backup in 
another location, Trimble recommends that you select a location other than within the AllTrak 
software (for example, a network location).

c. Click Next.

d. In the Scheduled Backup Time window, select the check box next to the 
time you want the backup to begin. 

To back up the database, the AllTrak DataServer must be open at the 
designated time. For more information, refer to the Help.

16. Click Next.

17. A summary of your selections appears in the Start Copying Files dialog. To 
accept the settings, click Next. The installation begins. This procedure may 
take a few minutes to complete.

18. Click Finish to complete the installation.

Place an icon onto the desktop for the 
DataServer program

Enables easy access to the DataServer.

Place icons onto the desktop for the 
Workstation programs

Places icons for the AllTrak software and AllTrak 
utilities on the desktop.

Note – This option does not appear if you are 
installing only the DataServer.

Check box Description
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Completion

Before you begin working in the database, complete the following procedures:

Trimble Quick Link Configuration

Refer to the Chapter 7, Preliminary Settings of this manual to configure the Trimble 
Quick Link Management Studio. If you have installed as a network, you should 
complete this configuration prior to installing the workstations.

Complete DataServer settings

Define additional values and run commands as required to set up DataServer 
parameters. See AllTrak DataServer, page 40. 

Workstation

If you installed the AllTrak software on a network, you must install the software on 
each workstation requiring access to the AllTrak database. (This is required in order 
for the workstations to run the software.) See Chapter 5, Workstation Installation.

Starting the AllTrak software

When the AllTrak installation is complete, see Chapter 7, Preliminary Settings for 
instructions on starting AllTrak from the computer designated as the database server 
or on a stand-alone machine.

Adobe Reader

To view the online manuals, you need Adobe Reader. See Chapter 6, Adobe® 
Reader®.

Windows Mobile devices

If you purchased a Trimble Nomad handheld for use with the AllTrak software, refer 
to the AllTrak Software Barcodes and Scanners Guide for instructions on configuring 
the device. 
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5

Workstation Installation 5

In this chapter:

■ Preliminary steps

■ Installation procedures

If you install the AllTrak software on a network, 
you must also install the workstation software at 
each workstation that needs access to the 
database. This step activates the software on 
each workstation so it can communicate with the 
AllTrak DataServer.

Before you begin workstation installations, 
install the AllTrak software on the designated 
server computer.
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Preliminary steps
Before you install the software:

• You must have administrator privileges in order to install the software.

• It is your responsibility to install the required software and connect the 
hardware (if necessary).

• Close all Windows-based applications on the server, including e-mail software.

Quick Link Hub IP Address

Before you can install Trimble AllTrak, the installation routine must validate 
installation and communication of the Quick Link Hub. You must have this 
information available to proceed. 

IP address

During the Workstation installation you must enter the TCP/IP address and Port 
number to access the computer where the DataServer is installed. For instructions on 
how to obtain this information at the AllTrak DataServer computer, see Verifying that 
TCP/IP is installed, page 11. You should have this information available before you 
begin the installation process.

Common installation commands

During the installation process, you will see the following in many of the windows:

• To proceed with the installation and advance to the next window, click Next.

• To return to the previous page, click Back.

• To stop the installation, click Cancel. Either click Yes to confirm the 
cancellation or click No to continue the installation.

• To complete the installation, click Finish.

Your TCP/IP address 
will be different than the 
one in the graphic. Do 
not use this address! 
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Insert DVD
1. Insert the AllTrak Installation DVD into the appropriate drive of the computer 

designated as the stand-alone or server computer. Wait a moment. 

2. If the installation does not start a few seconds after you insert the installation 
DVD, proceed as follows:

– Double-click on the My Computer icon.

– Locate the drive containing the AllTrak Installation DVD. Click on it to 
display the contents of the DVD. 

– Double-click AutoRun.exe to open the AllTrak main installation screen.

Installation procedures

BTip – You must have the TCP/IP Address and TCP/IP Port for the Quick Link Hub. If you have not 
yet installed the Trimble® Quick Link software, you must do so before you can install the 
AllTrak software.

1. Select Install: Trimble AllTrak.

2. Trimble has built-in several validations to ensure Trimble® Quick Link and the 
Alltrak software can communicate properly after installation. Your Quick Link 
Hub must be validated before you can continue the installation. 

a. In the Check Quick Link Installation dialog, enter the following 
information:

Hub Address
This is the TCP/IP Address assigned to the Quick Link Hub.

Port
This is the TCP/IP Port assigned to the Quick Link Hub. Note: The default 
Port should always be 31958.

b. Click Continue Install.

c. Validation Procedure
When you click Continue Install, the application validates the installation 
and communication with the Quick Link Hub. 

– If the installation/communication is validated, the installation routine will 
proceed. Go to Step 3 below.

– If installation/communication cannot be validated, click Go Back and 
make sure you have entered the correct information. Make any necessary 
corrections and then click Continue Install again. Go to step 3 below.

BTip – If you have entered the correct information and the data cannot be validated, you will need 
assistance from your IT Professional. Trimble has provided an Installation Checklist document 
to step through some troubleshooting procedures in order to make sure your environment 
allows the proper required communication.
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3. The Welcome to the Installation Wizard for AllTrak dialog appears. Click Next.

4. The License Agreement dialog appears. Read the agreement. Select the I accept 
the terms of the license agreement option and then click Next.

5. The Support Service Agreement dialog appears. Read the agreement. Select the 
I accept the terms of the support license agreement option and then click Next.

BTip – You must accept the terms of the agreement to proceed with the installation. If you want a 
hard copy of the agreement, click Print.Depending on the operating system installed on your 
computer, the Access Control Options screen may appear. Select one of the following options:

6. Click Next.

7. In the Select AllTrak Options dialog, select the AllTrak Workstation option and 
then click Next.

8. The Choose AllTrak Destination Location dialog appears. Trimble 
recommends that you install the software in the default location. Click Next.

9. The Select Other Options dialog appears. Select the Place icons onto the 
desktop for the Workstation programs option. This option places icons for the 
client side of the AllTrak software on the desktop for easy access. Click Next.

10. The TCP/IP (Internet Protocol Address) connects the workstation to the 
computer where the DataServer is installed. The port identifies how to access 
the DataServer software on the network computer. In the Enter TCP/IP and 
Port dialog, enter the following information:

11. Click Next.

12. In the Select Program Folder dialog, you can select how you want the AllTrak 
software to appear in your program list. Trimble recommends that you accept 
the default setting. Click Next.

Option Description

Access is allowed for 
anyone who uses this 
computer (all users)

This allows anyone who logs into your computer (regardless of 
user name) to access the database. However, they must be 
granted proper security rights in the AllTrak software.

Access is allowed only 
by me (computer or 
user name displays)

This allows only the login that matches the computer or user name 
to access the database.

Option Description

TCP/IP This is the address of the computer where the DataServer is installed. If you do 
not know the address, see page 11 or contact your System Administrator.

C CAUTION – This field contains a default to the Stand-Alone IP 
address. To provide connectivity to the DataServer, you must enter 
the appropriate IP address for the server.

Port Enter the port number you will use to access the AllTrak DataServer. If you need 
help with this setting, contact your System Administrator.
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13. A summary of your selections appears in the Start Copying Files dialog. If you 
are satisfied with the data displayed, click Next. The installation begins. Please 
be patient as this procedure may take a few minutes to complete.

14. Click Finish to complete the installation.

Completing the workstation installation

If this is the first time you have installed the AllTrak software, complete the following 
procedures before you begin working in the database:

Trimble Quick Link Configuration

Refer to the Chapter 7, Preliminary Settings of this manual to configure the Trimble 
Quick Link Management Studio. If you have installed as a network, you should 
complete this configuration prior to installing the workstations.

Starting the AllTrak software

When the AllTrak installation is complete, see Open the AllTrak software, page 45 
for instructions on starting the AllTrak software from the computer designated as the 
database server or on a stand-alone machine.

Adobe Reader

To view the online manuals, you need Adobe Reader. See Chapter 6, Adobe® 
Reader®.

Windows Mobile devices

If you purchased a Trimble Nomad handheld for use with the AllTrak software, refer 
to the AllTrak Software Barcodes and Scanners Guide for instructions on configuring 
the device. 
AllTrak Software Installation Guide     34



5      Workstation Installation
35      AllTrak Software Installation Guide



C H A P T E R

6

Adobe® Reader® 6

In this chapter:

■ Adobe Reader information

■ Installation requirements

■ Download/Install Adobe Reader

The AllTrak software includes online manuals in 
a portable document format (PDF). Direct access 
hyperlinks throughout the manuals provide easy 
access to various topics. You can also print all, 
or part of, the manual. 

B Tip – If Adobe Reader is already installed 
on the workstation, it must be at least 
version 7 to open and view the AllTrak 
manuals.

Trimble recommends that you install 
the latest version of the reader 
available.
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Adobe Reader information
To verify that you have Adobe Reader version 6 or later installed on your computer:

1. Open Adobe Reader. Select Help / About.

Note – Depending on the version of the Reader you have installed, the command may 
read Adobe Acrobat Reader or Adobe Reader.

2. In the product information window, verify that the version is 6 or later.

– If it is, no further action is necessary. However, Trimble recommends that 
you install a current version of the reader.

– If not, you must install Adobe Reader.

Installation requirements
• If you have installed the AllTrak software on a network with workstations, you 

must install Adobe Reader on each workstation. This provides access to the 
manuals for all users using the AllTrak software.

• If you have installed the AllTrak software on a stand-alone computer, you must 
install Adobe Reader on the stand-alone computer.

Download/Install Adobe Reader
To install a free copy of Adobe Reader, follow the instructions below.

Adobe Reader is not installed on your system

1. Insert the Trimble AllTrak installation DVD into the appropriate drive of the 
stand-alone or workstation computer. Wait a moment. The main installation 
screen displays.

2. Under Install, click Adobe® Reader®.

3. The Adobe Systems Incorporated website opens. Locate the Download area on 
the home page.

4. Locate Adobe Reader. Follow the on-screen instructions.

Note – the following:

If you have an older version of Adobe Reader, you may receive a message indicating 
that the older version must be removed prior to installing the new version. If you 
receive this message, proceed with the removal process. Once removal is complete, 
go back to Step 1 and begin the installation again.
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Preliminary Settings 7

In this chapter:

■ Trimble Quick Link Configuration

■ AllTrak DataServer

■ Backup settings

■ Client-requested options

■ Scheduled database backups

■ Access/Final steps

■ Open the AllTrak software

■ Passwords and Rights

When you complete the installation of the 
AllTrak software, you are ready to create the 
backup settings in the DataServer. For security 
purposes, you should also change initial 
passwords and create a system administrator for 
the AllTrak client (stand-alone or workstation). 

Before proceeding with the directions contained 
in this chapter, make sure you have completed 
the installation steps outlined in Chapter 4, 
Network/Stand-Alone Installation and, if 
necessary, Chapter 5, Workstation Installation.

This chapter provides you with preliminary 
instructions on procedures that you should 
complete immediately after the installation is 
complete.
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Trimble Quick Link Configuration

Before you can use the Trimble Quick Link Management Studio, it must be 
configured to communicate with the Hub.

The Quick Link Management Studio requires a login name and password. This 
provides security for other sensitive information and your product licenses. Trimble 
Quick Link includes defaults that allow you initial access to the database. You can 
add users/passwords under Tools > Quick Link Employees. See the Trimble Quick 
Link online help system for instructions.

1. Open the Trimble Quick Link Management Studio using one of the following 
methods:

:

Click  on your Desktop.
OR
Go to the Windows Start menu and navigate to Trimble® Quick Link. Click on 
it and then click Management Studio. 

BTip – The Trimble® Quick Link Hub must running before you can open the Trimble® Quick Link 
Management Studio.

2. In the Connect to the Trimble® Quick Link Hub screen, enter the following:

Login Name
admin

Password
admin

BTip – We recommend that you change the password for the default login as soon as 
possible in order to protect your data. Make note of the new password.

3. If you want to save the password for future use, click the Remember 
Password checkbox. 

4. Review the information presented on this screen and then enter the IP Address 
for the Trimble Quick Link Hub.

C CAUTION – Do not change the Port number. Changing the Port number will cause connectivity 
conflicts to the Hub (based on firewall settings). It is highly recommended that the default Port number is 
used. Contact your system administrator for more info

5. Click OK. The Quick Start Wizard opens. This wizard guides you through 
setting up the Management Studio for proper licensing and communication. 
Refer to the Trimble Quick Link online help system for instructions on 
completing the wizard.
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AllTrak DataServer

Opening the DataServer

Depending on your settings, the DataServer may open automatically when you start 
your computer. In most cases, it will also start automatically when you open the 
client-side of the AllTrak software. In each of these cases, the DataServer is 
minimized and available in the Windows System Tray. See Minimizing the 
DataServer, page 40.

Do one of the following:

– Double-click on the  icon on your desktop.

– From the Windows Start menu, select Programs / Trimble Office / Trimble 
AllTrak / Trimble AllTrak DataServer. 

The AllTrak DataServer window opens.

Minimizing the DataServer

If the AllTrak DataServer is minimized in the Windows System Tray, double-click on 
it and the window opens:

Minimize DataServer

When you are done working in the AllTrak DataServer window, you can minimize it 
using one of the following methods:

• In the upper right corner of the window:

– Click . 

– Click .

Closing the DataServer

To close the AllTrak DataServer, select File > Exit. 

Note – If users are connected to the DataServer when you close it, everyone will be 
automatically disconnected. To send a message advising everyone to log out, select 
Tools > Messaging or File > Timed Shutdown.

Trimble AllTrak DataServer
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Backup settings
With any software, you should perform periodic backups of your data to safeguard 
against data loss.

C CAUTION – You must complete the procedures outlined in order to produce accurate and timely 
backups of your database. Failure to complete these procedures may result in improper creation of 
system backups.

The procedures covered in this topic detail only setting the backup parameters. For 
information about creating backups and/or restoring data, refer to the Maintenance 
section in the Help.

Backup login

To perform many of the backup and restore functions, you must log in to the database. 
This feature provides additional security for database protection.

BTip – Initial login and password is included on the last page of this manual. You must have 
appropriate access rights to perform backups.

1. In the AllTrak DataServer window, select Backup and the command you want 
to perform. You will be required to login. The following is an example of the 
Login for Backup dialog. Other login windows are similar in content and 
appearance.

2. Complete the following fields:

3. Click OK.

The window associated with the selected command opens.

Field Description

Login name Enter your login name. 

Note – In some cases, your Windows system login name may appear 
in the field. Highlight the entire text and then enter the appropriate 
password in the field.

Password Enter the password required to access backups. (See the last page of 
this manual for password information.)
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Client-requested options
Default backup options are set in the AllTrak DataServer. This procedure allows you 
to modify the default settings based on your company policy.

1. In the AllTrak DataServer window, select Backup / Client Backup Options.

2. Log in using the instructions on page 41. The Set Options for Client Backup 
Requests dialog appears:

3. Select one of the following options:

Because a separate file is created each time, maintenance is required to avoid 
disk space problems. Trimble recommends that you develop a policy for 
retaining older backup files of your AllTrak system.

BTip – Trimble recommends that you save your backup to a location outside of the AllTrak program 
files on your computer; for example, a network drive.

4. If required, select the Check Database Integrity before the backup checkbox 
to locate and correct errors. This locates errors and broken links and 
automatically corrects them.

Option Description

Single Archive This option overwrites the previous backup file. This option 
requires less attention to disk space maintenance, but it does not 
preserve previous periodic backup files.

When you select the Single Archive option, you must also enter a 
location (drive and folder) and file name in the File field. 

The file name selected is the name of your single archive file each 
time you create a backup. For example, you could use AT Full 
Backup as the backup file name. All backup files created will be 
called AT Full Backup.qpb.

Multiple Archive This option creates a separate file each time a back up is created. 
This option preserves all previous backup files.

When you choose the Multiple Archive option, you must also 
specify the Directory (folder) where you want the backups created. 

The software automatically generates the file name in the format 
YYYY-MM-DD HHMM.SS.QPB. For example, a backup file 
created on 28 August 2009 at 11:15.25AM will be called 2009-08-
28 1115.25.qpb. 
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5. Click OK.

6. When you finish working in the AllTrak DataServer, do one of the following:

– To minimize the software, click  in the upper right-corner.

– To close the AllTrak DataServer, select File / Exit.

The defaults are now set and will be used for future client-requested backups. You can 
overwrite these defaults when you perform backups from the AllTrak DataServer, but 
backups performed from the client-side of the AllTrak software are created based on 
the settings selected in the Client Backup Options dialog.

Scheduled database backups
The AllTrak software includes the option of creating regularly scheduled backups, 
daily at the time you specify. This option protects your data without requiring your 
action. Other options can be scheduled at the same time scheduled backups are 
performed.

Scheduled backups are not automatically saved from day to day. Each backup 
overwrites the backup from the previous day. Contact your system administrator for 
information on how your company-wide system backups are handled.

BTip – The AllTrak DataServer must be running to produce a scheduled backup. If the DataServer is 
closed, a backup cannot be created.

Parameters for daily backups may have been set during the installation process. If 
these were not set or you want to modify these parameters, complete the following 
steps.

1. In the AllTrak DataServer window, select Backup > Scheduled Backup 
Options. 

2. Log in using the instructions on page 41. The Scheduled Backup dialog opens:

3. Select the Perform a daily scheduled backup of the database check box.
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4. Complete the following information in the Options group:

Field Description

Location 1. Enter the location (drive letter, folder, and file name) where 
you want the scheduled backup created. You can select 
Default Backup Location from the list or click  to browse 
to the required location. The Select scheduled backup up file 
dialog appears: 

2. Browse to the required backup location.

3. Enter the required backup file name and then click Save.

Note – Trimble recommends that you select a location other 
than the hard drive where the AllTrak software is installed.

Backup the 
database daily

Note – Network users: Ensure that you allow enough time for 
your daily backup to complete before your server system backup 
begins. Because the DataServer must remain open for a 
scheduled backup, none of the AllTrak files will be included in 
your server backup. The scheduled backup file will be included if 
you create the file on your network server, provided it is 
completed. For more information, contact your system 
administrator.

Do one of the following:

• Click  and then select the time you want the scheduled 
backup created. 

• Enter the data in the format: HH:MM:SS AM or HH:MM:SS 
PM. 

You might want to choose a time when no one is working in the 
AllTrak software. While the backup is being created, it will slow 
processing for other users. 

Truncate the 
database log file 
every week on

Choose an option from the list. The AllTrak DataServer saves all 
transactions made in the database. The information is stored in 
the database log file. After extensive use of the database, the 
size of this file may become unmanageable. The truncate feature 
reduces the size of the file on a weekly basis.

C CAUTION – The database log file is included in all full 
backups. Trimble recommends that you truncate the 
database logs on a weekly basis only if you have 
performed periodic full backups.

Check the database 
integrity every 
week on

Checking the database integrity locates errors and broken links 
and automatically corrects them. 

Note – This feature does not look at individual projects.

To check the integrity of the database before creating a backup, 
select the Check Database Integrity before the backup check box 
in the appropriate window.

C CAUTION – Trimble recommends that you regularly 
check the integrity of the database. Keep in mind that 
the integrity check may take several hours (depending on 
the size of your database). Ideally, perform this function 
when no one is using the AllTrak software.

Click OK. The backup will be created at the time you specify. 
Ensure that you leave the AllTrak DataServer open or the backup 
cannot be created.
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Access/Final steps

Additional information

Before you can open the AllTrak software, the DataServer must be open and running: 

• Verify that the Trimble Quick Link Hub is running.

• If you are using the application on a stand-alone computer, the DataServer 
automatically opens when you start the AllTrak software.

• If you are using the application on a network, ensure that the DataServer is 
open and running on the computer designated as the server.

Open the AllTrak software
1. Do one of the following:

– Double-click the  icon on your Windows desktop.

– From the Windows Start menu, navigate to Trimble Office > Trimble 
AllTrak.

The AllTrak Login dialog opens:

2. Complete the following fields:

C CAUTION – Your Windows login name may display as a default in the Login name field. Highlight 
the entire field and then enter the login name specified.

3. Click OK. The main AllTrak window opens.

Option Description

Login name Enter admin in the Login name field.
Password Enter the password to access the AllTrak software. The password is 

provided on page 52. 

The copyright date may change 
from version to version.
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Passwords and Rights
The software includes a default user and password. The default user has system 
administrator rights, which means that anyone logging in using this default has access 
to all areas of the AllTrak software. The AllTrak software contains security that 
allows each employee access to only those areas required. For more information on 
access rights, refer to the Employees and Security section in the online help system.

You can continue using the provided defaults, but to safeguard your data, Trimble 
recommends that you change the password immediately and that you create a 
system administrator in the database that is specific to your company.

For more information, see Changing the initial password, page 46 and Creating a 
system administrator, page 48.

Changing the initial password

The initial access password provided allows access to all areas of the AllTrak 
software. To protect your data, Trimble recommends that you change this password 
immediately.

1. In the main AllTrak window, select Settings / Employees. The List of employees 
window opens.

2. Do one of the following:

– Click Admin and then select Edit > Edit Employee.

– Right-click Admin and then select Edit Employee from the shortcut 
menu.

– Double-click Admin.
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The Employee: Admin Admin dialog appears:

BTip – If you are using a Proximity Card and Security Reader, scan the card for this employee while 
on this tab. This information will automatically populate the Security ID field, linking the card 
codes to this employee.

3. Select the Security tab.

4. Click in the Password field. Highlight the entire field and then enter the new 
password and then click OK. 

Note – Make a note of the new password.

5. After you modify the default password, Trimble recommends that you close the 
AllTrak software completely (including the AllTrak DataServer) to allow the 
DataServer to recognize the new password.

BTip – When you reopen the software, you must use the new password.

To continue with the remaining procedures, reopen the AllTrak software and the 
AllTrak DataServer.
47      AllTrak Software Installation Guide



Preliminary Settings     7
Creating a system administrator

Trimble recommends that you add at least one AllTrak system administrator who will 
be the primary person(s) responsible for maintaining the AllTrak database. To add an 
employee administrator to the AllTrak database:

1. In the main AllTrak window, select Settings / Employee List. The List of 
employees dialog appears:

2. In the List of employees window, do one of the following.

– Click on the  on the toolbar.

– Select Edit > Add Employee.

– Press [Ctrl]+[Insert] on your keyboard.
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The Add Employee Details dialog appears:

The choices you make in the General Settings group, determine what tabs are 
available.

BTip – All fields that appear in bold are required.
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General tab

1. Enter the following applicable information in the fields provided: 

– First Name

– Middle

– Last Name

– Initials – If applicable, this field can also be used for nicknames.

– Employee ID Security ID – This field is required if you are using a 
Proximity Access/Security Card to log in to the AllTrak software or when 
performing asset transactions. Place the cursor in this field and then scan 
the security card. This associates the employee with the card 
identification. 

Note – The access code appears in the field with asterisks. This ID must 
match the ID/Login scanned on the AllTrak Login screen or when 
performing asset transactions. Access codes must be unique for each 
employee.

– Title

2. Choose Main from the Branch list. You can change this assignment later.

3. If you are producing employee ID badges from the AllTrak software (as 
defined in the Reports module) and you want to monitor dates, enter a value in 
the ID Badge Expires field in the format MM/DD/YYYY. Alternatively, click 

 to select a date from the system calendar.

4. In the General Settings group, select the following applicable check boxes:

5. Select the Security tab to continue setting up this employee.

The Security tab is visible only when the Can use Trimble AllTrak option is 
selected on the General tab.

Option Description

Can use AllTrak This option is available only if you have system administrator 
rights. This setting allows the employee to work in the AllTrak 
database. When this option is selected, you must also set 
Security and Access rights. See Security tab, page 51.

Can be responsible for 
assets

When this option is selected, the employee is allowed asset 
responsibility in transactions. When an asset transaction is 
performed, only those employees who have this option 
selected can be responsible for the asset. 
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Security tab

Set the Login name, Password, and Access Rights for an employee:

1. Enter the employee’s Login Name. The field is required in combination with 
the Password when the employee opens the AllTrak software.

2. Enter a Password for the employee. The field is required in combination with 
the Login name when the employee opens the AllTrak software.

3. In the Access Rights group, select the System Administrator check box. When 
you select this option, the employee can perform all functions in the AllTrak 
software. Trimble recommends that you limit the number of employees 
assigned system administrator rights. This provides better protection of the 
AllTrak data. If you select this option for the employee, all required data is 
complete on this tab.
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Login name: Admin

Initial password: admin

Note – Trimble recommends that you change the initial password immediately after 
installation to prevent unauthorized individuals from accessing the database.
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